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Notice

© Keysight Technologies, Inc. 1983-2016
1400 Fountaingrove Pkwy., Santa Rosa, CA 95403-1738, United States

All rights reserved.

No part of this documentation may be reproduced in any form or by any means (including electronic storage
and retrieval or translation into a foreign language) without prior agreement and written consent from
Keysight Technologies, Inc. as governed by United States and international copyright laws.

Restricted Rights Legend

If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is
delivered and licensed as "Commercial computer software" as defined in DFAR 252.227-7014 (June 1995),
or as a "commercial item" as defined in FAR 2.101(a) or as "Restricted computer software" as defined in FAR
52.227-19 (June 1987) or any equivalent agency regulation or contract clause.

Use, duplication or disclosure of Software is subject to Keysight Technologies' standard commercial license
terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than
Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no
greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2)
(November 1995), as applicable in any technical data.

Acknowledgments
Layout Boolean Engine by Klaas Holwerda, v1.7 http://boolean.klaasholwerda.nl/bool.html

FreeType Project, Copyright (c) 1996-1999 by David Turner, Robert Wilhelm, and Werner Lemberg.
QuestAgent search engine (c) 2000-2002, JObjects.

Portions of the code Copyright (c) 1990-1996

The Regents of the University of California. All rights reserved. Permission is hereby granted, without written
agreement and without license or royalty fees, to use, modify and distribute the Ptolemy software and its
documentation for any purpose, provided that the above copyright notice and the following two paragraphs
appear in all copies of the software and documentation.

In no event shall the University of California be liable to any party for direct, indirect, special, incidental, or
consequential damages arising out of the use of this software and its documentation, even if the University
of California has been advised of the possibility of such damage.

The University of California specifically disclaims any warranties, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose. The software provided hereunder is on an
"as is" basis and the University of California has no obligation to provide maintenance, support, updates,
enhancements, or modifications.

Portions of this product include the SystemC software licensed under Open Source terms, which are
available for download at http://systemc.org/. This software is redistributed by Keysight. The Contributors of


http://boolean.klaasholwerda.nl/bool.html
http://systemc.org/

the SystemC software provide this software "as is" and offer no warranty of any kind, express or implied,
including without limitation warranties or conditions or title and non-infringement, and implied warranties or
conditions merchantability and fitness for a particular purpose. Contributors shall not be liable for any
damages of any kind including without limitation direct, indirect, special, incidental and consequential
damages, such as lost profits. Any provisions that differ from this disclaimer are offered by Keysight only.

Motif is a trademark of the Open Software Foundation.
Netscape is a trademark of Netscape Communications Corporation.
UNIX is a registered trademark of the Open Group.

Microsoft, Windows, Windows NT, Windows 2000, and Windows Internet Explorer are registered trademarks
of Microsoft Corporation in the United States and other countries.

Pentium is a registered trademark of Intel Corporation.
Acrobat, PDF, and PostScript are registered trademarks of Adobe Systems Incorporated.

FLEXIm and FLEXnet are registered trademarks of Flexera Software LLC Terms of Use for Flexera Software
information can be found at http://www.flexerasoftware.com/company/about/terms.htm

Netscape Portable Runtime (NSPR), Copyright (c) 1998-2003 The Mozilla Organization. A copy of the Mozilla
Public License is at http://www.mozilla.org/MPL/

FFTW, The Fastest Fourier Transform in the West, Copyright (c) 1997-1999 Massachusetts Institute of
Technology. All rights reserved.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of
their respective owners.

Cadence, Allegro, Assura, Dracula, SKILL, Spectre, and Virtuoso are registered trademarks of Cadence
Design Systems, Inc. in the United States and/or other jurisdictions.

Mentor, Mentor Graphics, Board Station, Calibre, and Expedition are registered trademarks of Mentor
Graphics Corporation in the United States and other countries.

SystemC is a registered trademark of Open SystemC Initiative, Inc. in the United States and other countries
and is used with permission.

Gradient, HeatWave and FireBolt are trademarks of Gradient Design Automation Inc.
The following third-party libraries are used by the NlogN Momentum solver:

Metis 4.0, Copyright © 1998, Regents of the University of Minnesota", http://www.cs.umn.edu/~metis,
METIS was written by George Karypis (karypis@cs.umn.edu).

Intel@ Math Kernel Library, http://www.intel.com/software/products/mkl
HSPICE is a registered trademark of Synopsys, Inc. in the United States and/or other countries.

DWG and DXF are registered trademarks of Autodesk, Inc. in the United States and/or other countries.
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MATLAB is a registered trademark of The MathWorks, Inc. in the United States and/or other countries.
SuperLU_MT version 2.0

SuperLU Copyright: Copyright © 2003, The Regents of the University of California, through Lawrence
Berkeley National Laboratory (subject to receipt of any required approvals from U.S. Dept. of Energy). All
rights reserved.

SuperLU Disclaimer: THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

7-zip
7-Zip Copyright: Copyright (C) 1999-2009 Igor Pavlov.
Licenses for files are:

1. 7z.dll: GNU LGPL + unRAR restriction.
2. All other files: GNU LGPL.

7-zip License: This library is free software; you can redistribute it and/or modify it under the terms of the
GNU Lesser General Public License as published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is distributed in the hope that it will be useful,but
WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details. You should have
received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA.

unRAR copyright: The decompression engine for RAR archives was developed using source code of unRAR
program.All copyrights to original unRAR code are owned by Alexander Roshal.

unRAR License: The unRAR sources cannot be used to re-create the RAR compression algorithm, which is
proprietary. Distribution of modified unRAR sources in separate form or as a part of other software is
permitted, provided that it is clearly stated in the documentation and source comments that the code may
not be used to develop a RAR (WinRAR) compatible archiver.

7-zip Availability: http://www.7-zip.org/
AMD Version 2.2
AMD Notice: The AMD code was modified. Used by permission.

AMD copyright: AMD Version 2.2, Copyright © 2007 by Timothy A. Davis, Patrick R. Amestoy, and lain S.
Duff. All Rights Reserved.
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AMD License: Your use or distribution of AMD or any modified version of AMD implies that you agree to this
License. This library is free software; you can redistribute it and/or modify it under the terms of the GNU
Lesser General Public License as published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is distributed in the hope that it will be useful, but
WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details. You should have
received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby
granted to use or copy this program under the terms of the GNU LGPL, provided that the Copyright, this
License, and the Availability of the original version is retained on all copies.User documentation of any code
that uses this code or any modified version of this code must cite the Copyright, this License, the Availability
note, and "Used by permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice that the code was
modified is included.

AMD Availability: http://www.cise.ufl.edu/research/sparse/amd

UMFPACK 5.0.2

UMFPACK Notice: The UMFPACK code was modified. Used by permission.

UMFPACK Copyright: UMFPACK Copyright © 1995-2006 by Timothy A. Davis. All Rights Reserved.

UMFPACK License: Your use or distribution of UMFPACK or any modified version of UMFPACK implies that
you agree to this License. This library is free software; you can redistribute it and/or modify it under the
terms of the GNU Lesser General Public License as published by the Free Software Foundation; either version
2.1 of the License, or (at your option) any later version. This library is distributed in the hope that it will be
useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS
FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details. You should have
received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby
granted to use or copy this program under the terms of the GNU LGPL, provided that the Copyright, this
License, and the Availability of the original version is retained on all copies. User documentation of any code
that uses this code or any modified version of this code must cite the Copyright, this License, the Availability
note, and "Used by permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice that the code was
modified is included.

UMFPACK Availability: http://www.cise.ufl.edu/research/sparse/umfpack UMFPACK (including versions
2.2.1 and earlier, in FORTRAN) is available at http://www.cise.ufl.edu/research/sparse. MA38 is available in
the Harwell Subroutine Library. This version of UMFPACK includes a modified form of COLAMD Version 2.0,
originally released on Jan. 31, 2000, also available at http://www.cise.ufl.edu/research/sparse. COLAMD V2.
0 is also incorporated as a built-in function in MATLAB version 6.1, by The MathWorks, Inc. http://www.
mathworks.com. COLAMD V1.0 appears as a column-preordering in SuperLU (SuperLU is available at
http://www.netlib.org). UMFPACK v4.0 is a built-in routine in MATLAB 6.5. UMFPACK v4.3 is a built-in
routine in MATLAB 7.1.

Errata
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The ADS product may contain references to "HP" or "HPEESOF" such as in file names and directory names.
The business entity formerly known as "HP EEsof" is now part of Keysight Technologies and is known as
"Keysight EEsof". To avoid broken functionality and to maintain backward compatibility for our customers,
we did not change all the names and labels that contain "HP" or "HPEESOF" references.

Qt Version 4.8.4
Qt Notice: The Qt code was modified. Used by permission.

Qt Version 4.8.4, Copyright (C) 2014 Digia Plc and/or its subsidiary(-ies). All Rights Reserved. Contact:
http://www.qt-project.org/legal

Qt License: http://qt-project.org/doc/qt-4.8/lgpl.html. Your use or distribution of Qt or any modified version
of Qt implies that you agree to this License. This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as published by the Free Software Foundation;
either version 2.1 of the License, or (at your option) any later version. This library is distributed in the hope
that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License
for more details. You should have received a copy of the GNU Lesser General Public License along with this
library; if not, write to the Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-
1301 USA Permission is hereby granted to use or copy this program under the terms of the GNU LGPL,
provided that the Copyright, this License, and the Availability of the original version is retained on all copies.
User documentation of any code that uses this code or any modified version of this code must cite the
Copyright, this License, the Availability note, and "Used by permission." Permission to modify the code and to
distribute modified code is granted, provided the Copyright, this License, and the Availability note are
retained, and a notice that the code was modified is included.

Qt Availability: http://www.qgtsoftware.com/downloads

Patches Applied to Qt can be found in the installation at: $HPEESOF_DIR/prod/licenses/thirdparty/qt
/patches.

You may also contact Brian Buchanan at Keysight Inc. at brian_buchanan@keysight.com for more
information.

The HiSIM_HV source code, and all copyrights, trade secrets or other intellectual property rights in and to
the source code, is owned by Hiroshima University and/or STARC.

HDF5

HDF5 Notice: The HDF5 code was modified. Used by permission.

HDF5 Copyright: Copyright 2006-2013 by The HDF Group.

HDF5 License:

Copyright Notice and License Terms for HDF5 (Hierarchical Data Format 5) Software Library and Utilities
HDF5 (Hierarchical Data Format 5) Software Library and Utilities

Copyright 2006-2013 by The HDF Group.
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NCSA HDF5 (Hierarchical Data Format 5) Software Library and Utilities
Copyright 1998-2006 by the Board of Trustees of the University of Illinois.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted for any
purpose (including commercial purposes) provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and
the following disclaimer in the documentation and/or materials provided with the distribution.

3. In addition, redistributions of modified forms of the source or binary code must carry prominent
notices stating that the original code was changed and the date of the change.

4. All publications or advertising materials mentioning features or use of this software are asked, but not
required, to acknowledge that it was developed by The HDF Group and by the National Center for
Supercomputing Applications at the University of Illinois at Urbana-Champaign and credit the
contributors.

5. Neither the name of The HDF Group, the name of the University, nor the name of any Contributor may
be used to endorse or promote products derived from this software without specific prior written
permission from The HDF Group, the University, or the Contributor, respectively.

libpng

libpng Copyright: libpng versions 1.2.6, August 15, 2004, through 1.6.3, July 18, 2013, are Copyright (c)
2004, 2006-2013.

libpng License: This copy of the libpng notices is provided for your convenience. In case of any discrepancy
between this copy and the notices in the file png.h that is included in the libpng distribution, the latter shall
prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices immediately following this sentence.

This code is released under the libpng license.

libpng versions 1.2.6, August 15, 2004, through 1.6.3, July 18, 2013, are Copyright (c) 2004, 2006-2013
Glenn Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-1.2.5
with the following individual added to the list of Contributing Authors, Cosmin Truta

libpng versions 1.0.7, July 1, 2000, through 1.2.5 - October 3, 2002, are Copyright (c) 2000-2002 Glenn
Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-1.0.6 with the
following individuals added to the list of Contributing Authors

Simon-Pierre Cadieux, Eric S. Raymond, Gilles Vollant and with the following additions to the disclaimer:
There is no warranty against interference with your enjoyment of the library or against infringement. There is
no warranty that our efforts or the library will fulfill any of your particular purposes or needs. This library is
provided with all faults, and the entire risk of satisfactory quality, performance, accuracy, and effort is with
the user.



libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are Copyright (c) 1998, 1999 Glenn
Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-0.96, with the
following individuals added to the list of Contributing Authors: Tom Lane, Glenn Randers-Pehrson, Willem
van Schaik

libpng versions 0.89, June 1996, through 0.96, May 1997, are Copyright (c) 1996, 1997 Andreas Dilger
Distributed according to the same disclaimer and license as libpng-0.88, with the following individuals added
to the list of Contributing Authors: John Bowler, Kevin Bracey, Sam Bushell, Magnus Holmgren, Greg
Roelofs, Tom Tanner

libpng versions 0.5, May 1995, through 0.88, January 1996, are Copyright (c) 1995, 1996 Guy Eric Schalnat,
Group 42, Inc.

For the purposes of this copyright and license, "Contributing Authors" is defined as the following set of
individuals: Andreas Dilger, Dave Martindale, Guy Eric Schalnat, Paul Schmidt, Tim Wegner

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all
warranties, expressed or implied, including, without limitation, the warranties of merchantability and of
fitness for any purpose. The Contributing Authors and Group 42, Inc. assume no liability for direct, indirect,
incidental, special, exemplary, or consequential damages, which may result from the use of the PNG
Reference Library, even if advised of the possibility of such damage.

Permission is hereby granted to use, copy, modify, and distribute this source code, or portions hereof, for any
purpose, without fee, subject to the following restrictions:

1. The origin of this source code must not be misrepresented.

2. Altered versions must be plainly marked as such and must not be misrepresented as being the original
source.

3. This Copyright notice may not be removed or altered from any source or altered source distribution.

The Contributing Authors and Group 42, Inc. specifically permit, without fee, and encourage the use of this
source code as a component to supporting the PNG file format in commercial products. If you use this
source code in a product, acknowledgment is not required but would be appreciated.

OpenSSL

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the
original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses are
BSD-style Open Source licenses. In case of any license issues related to OpenSSL please contact openssl-
core@openssl.org.

OpenSSL License

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.



3. All advertising materials mentioning features or use of this software must display the following
acknowledgment: "This product includes software developed by the OpenSSL Project for use in the
OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote
products derived from this software without prior written permission. For written permission, please
contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product
includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.
openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL. This library is free for commercial and
non-commercial use as long as the following conditions are aheared to. The following conditions apply to all
code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL
documentation included with this distribution is covered by the same copyright terms except that the holder
is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this
package is used in a product, Eric Young should be given attribution as the author of the parts of the library
used. This can be in the form of a textual message at program startup or in documentation (online or textual)
provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.
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3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes cryptographic software written by Eric Young (
eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library being
used are not cryptographic related.

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application
code) you must include an acknowledgement: "This product includes software written by Tim Hudson (
tih@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution license \[including the
GNU Public Licence.]

Growl GNTP support:
[The "BSD licence"] Copyright (c) 2009-2010 Yasuhiro Matsumoto
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The name of the author may not be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Cuda
Cuda Redistributable Software - 1.8. Attachment A



In connection with Section 1.2.1.1 of this Agreement, the following files may be redistributed with software
applications developed by Licensee, including certain variations of these files that have version number or
architecture specific information embedded in the file name - as an example only, for release version 6.0 of
the 64-bit Windows software, the file cudart64_60.dll is redistributable.

Component : CUDA Runtime

Windows : cudart.dll, cudart_static.lib
MacOS : libcudart.dylib, libcudart_static.a
Linux : libcudart.so, libcudart_static.a
Android : libcudart.so, libcudart_static.a

Component : CUDA FFT Library
Windows : cufft.dll

MacOS : libcufft.dylib

Linux : libcufft.so

Android : libcufft.so

Component : CUDA BLAS Library
Windows : cublas.dll

MacOS : libcublas.dylib

Linux : libcublas.so

Android : libcublas.so

Component : CUDA Sparse Matrix Library
Windows : cusparse.dll

MacOs : libcusparse.dylib

Linux : libcusparse.so

Android : libcusparse.so

Component : CUDA Random Number Generation Library
Windows : curand.dll

MacOs : libcurand.dylib

Linux : libcurand.so

Android : libcurand.so

Component : NVIDIA Performance Primitives Library
Windows : nppc.dll, nppi.dll, npps.dll

MacOs : libnppc.dylib, libnppi.dylib, libnpps.dylib
Linux : libnppc.so, libnppi.so, libnpps.so

Android : libnppc.so, libnppi.so, libnpps.so

Component : NVIDIA Optimizing Compiler Library
Windows : nvwm.dll

MacOs : libnvvm.dylib

Linux : libnvvm.so

Component : NVIDIA Common Device Math Functions Library

Windows : libdevice.compute_20.bc, libdevice.compute_30.bc, libdevice.compute_35.bc
MacOs : libdevice.compute_20.bc, libdevice.compute_30.bc, libdevice.compute_35.bc
Linux : libdevice.compute_20.bc, libdevice.compute_30.bc, libdevice.compute_35.bc



Component : CUDA Occupancy Calculation Header Library
All : cuda_occupancy.h

Read more at: http://docs.nvidia.com/cuda/eula/index.html#ixzz30CrknWfU

Warranty The material contained in this document is provided "as is", and is subject to being changed,
without notice, in future editions. Further, to the maximum extent permitted by applicable law, Keysight
disclaims all warranties, either express or implied, with regard to this documentation and any information
contained herein, including but not limited to the implied warranties of merchantability and fitness for a
particular purpose. Keysight shall not be liable for errors or for incidental or consequential damages in
connection with the furnishing, use, or performance of this document or of any information contained herein.
Should Keysight and the user have a separate written agreement with warranty terms covering the material
in this document that conflict with these terms, the warranty terms in the separate agreement shall control.
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PCle 3.0 Compliance Test Bench

PCle 3.0 Compliance Test Bench

This section describes the following topics:

® |ntroduction to PCle 3.0

® Difference between PCle 2.0 and PCle 3.0

Installing PCle 3.0 Compliance Test Bench

PCle 3.0 Compliance Test Bench Simulation Setups

Running PCle 3.0 Compliance Tests on Infiniium Offline
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Introduction to PCle 3.0

Peripheral Component Interconnect (PCI) Express (PCle) is a serial point-to-point bus standard. The PCle 3.0 uses 128b

/130b encoding method, this reduces the line encoding overhead to just 1.5%. The bandwidth of PCle 3.0 standard is 8
Gbps, double the bandwidth of PCle 2.0.

About PCle 3.0 Compliance Test Bench

The PCle 3.0 Compliance Test Bench provides test benches for designing and analyzing the PCle 3.0 interface. It can be

used to:
® Perform electrical validation starting from pre-layout, post-layout to oscilloscope measurement
® Perform tests specified by the PCI-SIG community standard
® Perform analysis on Spread Spectrum Clocking (SSC), trainable equalization, and other transmitter tests

® Calculate the margin by which the test has failed in case of failures
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Difference between PCle 2.0 and PCle 3.0

The following table lists the differences between the PCle 2.0 and PCle 3.0 standards.

Signaling rate

Encoding method

Overhead

Scrambling

Effective Bandwidth

Bit timing

Jitter tolerance

Back Compatibility

PCle 2.0

5GT/s

8b/10b

20%

Optional

4 Gb/s

200 ps

44 ps

Gen1

PCle 3.0

8 GT/s

128b/130b

1.56%

Always

7.99 Gb/s

125 ps

14 ps

Gen1 and Gen 2
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Installing PCle 3.0 Compliance Test Bench

This section provides information on prerequisites and steps to install the PCle 3.0 Compliance Test Bench (CTB).

Prerequisites

Before using the PCle 3.0 CTB, ensure that the following softwares are installed:
® |nfiniium Offline (Version 05.30)
® PCle 3.0 Compliance App (Version 3.42)

® ADS 2015.01

After installing the PCle 3.0 CTB, launch the Infiniium Offline software to ensure the PCle 3.0 Test App is available under
Analyze > Automated Test Apps.

File Control Setup Display Trigger Measure Math |Analyze| Utilities Demos Help
__| Histogram...
| Mask Test...

@10y Joov oo ¥ U7231B/U7231C DDR3 Test App

Measurement Analysis (EZJIT)... | N6462A/N6462B DDR4 Test App

Jitter/Noise (EZJIT Complete)... || N5393D/N5393E PCIExpress Test App |
RTEye/Clock Recovery (SDA)... U7243B USB3 Test App
Equalization...

=
z
o
=
o
o
@
o
@
n

Install Instructions

To install the PCle 3.0 CTB:

1. Download the PCle3CTB.deb package.

2. Select DesignGuide > Add DesignGuide from the ADS Main window.
The Add DesignGuide dialog box is displayed.

3. Click Add Global DesignGuide.
4. Browse and select the PCle3CTB.deb package.

5. Click Open.
The PCle 3.0 Compliance Test Bench will be added.

6. Restart ADS.

7. Open a Schematic view and select DesignGuide.

The PCle 3.0 Compliance Test Bench will be listed under the DesignGuide menu.
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PCle 3.0 Compliance Test Bench
Simulation Setups

PCle 3.0 Compliance Test Bench Simulation Setups

The PCle 3.0 Compliance Test Bench (CTB) provides tests, which helps to understand the various aspects of the PCle bus
standard. It provides you the ability to create designs using the included models. You can refer to the included examples

when developing the designs. This Compliance Test Bench provides the following Models and Examples:
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. N

Rl PCle3 CTB:2 2

4 PCle3
» Connectors, Package and Models
+ Designs 55C
+ Trainable Equalization
» Transmitter Tests Signal Quality & Common Mode
» Equalization Preset Tests
» Add-in Card & Systern Board Tests
» PCle Channel Simulation
» Channel Compliance 5-Parameter
PCle 3.0 Compliance Test Bench Documentation

Models

Following is the list of models used in the PCle 3.0 CTB:
® Connector model includes S-parameter model for board-to-board connection
® Solder ball is a bar grid array (BGA) pin electrical model.

® Package model includes S-parameter model from die to the IC package

Stackup/Substrate is a standard 6 layer PCB stackup

Via models includes following three components
© Blind Via with separate Antipad: in this model, individual antipads are provided for each differential via
© Blind Via with common Antipad: in this model, same antipad is shared between two differential vias

© Standard Via with separate Antipad: in this model, standard vias are provided with separate antipads

Examples

Following is the list of examples included in the PCle 3.0 CTB:
® Designs SSC Examples
® Trainable Equalization Examples

® PCle Transmitter Tests Signal Quality and Common Mode Examples

Equalization Presets Tests Examples
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® Add-in Card and System-Board Tests Examples
® PCle Channel Simulation Examples

® Channel Compliance S-parameter Examples

Designs SSC Examples
Spread Spectrum Clocking (SSC) is a method of clocking used in PCle 3.0 to reduce the EMI interference caused by the

reference clock.

SSC_Clocking_Topology_OFF

This design displays a PCle 3.0 connection from transmitter to receiver. The signal flows through AMI transmitter
(Tx_AMI) to AMI receiver (Rx_AMI) through the channel. The channel comprises of the BGA package, transmission lines,
Via models, and Board connector. The Eye_Probe displays the signal reaching the receiver. In this design, the SSC is
disabled, that is the SSC_Amplitude and SSC_Frequency are set to 0 in the Tx_AMI model. The Transmitter (Tx_AMI)

Rz R R RZ
- R1 R=500hm$ R=50 O
R=30 Ohm & R=500hm "

transmits the PRBS data at a rate of 200Mbps.

Eye_Probe
Eye_Probet

Tx_AMI Instance Name
Tr_AMI1

[EI5 File EEsof_PCIES_Tx_SSC.ibs Select IBIS Fie...
Component EEsof_PCIE3_Tx_S5C - ]
Setaldsta Typ - Channel Index

[¥] use package
Package I Fin I Model I IVData | Driver Schedule I SubMode! I Aliss | AMI | PRBS I Encoder I Display |

AMI fle Cs\Jsers\manlkaurPCIe30_DesignGuide _verd.0_wrk\data\EEs:

AMI Parameters

Parameter list
Init_Returns_Impulse
GetWave_Exists
Use_Tnit_Qutput o User spedified v
Max_ Init_Aggressors

4 Model Specific
SpecifyFilterBy
Taps

Preshoot_Deemphasis [F] Use 'Setall data' setting
S5C_Amplitude
SSC_Frequency -

Parameter information

55C_Amplitude

(]

(Format Value 1.0e+007) (Description amplitude of 55C modulation signa *

L] 1 »
[] save Qut/InOut parameters

Additional Jitter
[T oi al

After running the simulation, the waveform is saved in the dat a/ wavef or s directory with the name

PCle_Channel_SSC_OFF _HDF5.h5.

SSC_Clocking_Topology_ON

This design displays a PCle 3.0 connection from transmitter to receiver. The difference from the above example is that the

SSC is enabled.
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Tx_AMI Instance Name

TeAMIL
18IS Fle C:\Users\manlkaur\PCle30_DesignGuide_ver 1.0_wrkid
Component  [EEsof_PCIE3_Tx_SSC -]

setaldata  Typ hd Channel Index

Use package

Padcge | Pin | Model | 1Data | Driver Schedue | SubModel | Aias | AMI | PRBS | Encoder | Display |

AMI fle  C:Wsers\mankaur PCle30_DesignGuide_ver 1.0_wrk\data\TX_

AMI Parameters

arameter list
Init_Retums_Impulse
GetWave_Bxists

55C_Amplitude

Use Init_Output 1.0e4007 Value -

Max_Init_Aggressors
4 Model Specific

SpecifyfFilterBy

Teps

Preshoot Deemphasis Use ‘Set all data" setting
plitude
_Frequency

I

E

Parameter information
(Format Value 1.0e+007) (Description amplitude of SSC modulation signa *

« M »

After running the simulation, the waveform is saved in the dat a/ wavef or ms directory with the name
PCle_Channel_SSC_ON_HDF5.h5.

Trainable Equalization Examples

Trainable_Equalization_Dashboard

It provides components that can be used to create designs for optimizing the equalization of Tx and Rx.

TX_Preset_Optimization

This design provides end-to-end channel optimization using DAC components. It helps in deciding the best preset and

equalization values at Tx and Rx. After running the simulation, click the Optimize icon or select Simulate > Optimize.

& =
I

=50 0

gt 1 opmesan
SavRAITER-0

CpimGaan

After running the simulation, the waveform is saved in the dat a/ wavef or rs directory with the name

PCle_Channel AMI_Preset HDF5.h5.
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PCle Transmitter Tests Signal Quality and Common Mode Examples

Transmitter_Test_ AMI
This design displays a PCle connection using the IBIS AMI models. In this design, the signal flows through the AMI

transmitter to the coupling capacitor through the channel. The channel comprises of the BGA package model,
transmission lines, and a Via model. The waveform extraction is performed at P-channel ( Eye_Probe_P) and N- channel (

Eye_Probe_N ) to analyze the AC and DC common mode noise traveling through the channel.

ChannelSim

ChannelSim1
NumberOfBits=100000
ToleranceMode=Auta
EnforcePassivity=yes
Mode=Bit-by-bit

5
=50 Ohm

After running the simulation, the waveform is saved in the dat a/ wavef or rs directory with the name

PCle_Transmitter_Test_CM_Analysis_Data_N.h5 and PCle_Transmitter_Test_CM_Analysis_Data_N.h5.

Transmitter_Test_TX_Generic

This design displays a PCle connection. The difference from the above example is that the signal flows from a Differential

Transmitter (Tx_Diff) to the coupling capacitors through the channel.

1_Blind_Via model_Separate_Antipad
sthematic

123 c

I__26 Transmission_Line_M

R14
R=500hm 1
R & ;‘13
Te_Diff R C=180rF
T_Diffd & s B om0 R=500hm
BitRate=8 Gbps R=500hm 2 R=500hm } Eac
Vhigh=1V
Viow=1.0V
RiseFallTime=40 psec = —
Mode=Bit File = =] -

After running the simulation, the waveform is saved in the dat a/ wavef or s directory with the name

PCle_Transmitter_Test_CM_Analysis_Data_N.h5 and PCle_Transmitter_Test_CM_Analysis_Data_N.h5.

Equalization Presets Tests Examples

Equalization_Preset

This design is used to validate the preset values of Tx. You can change the value of Preset_Index from 0 to 10 and
simulate the design at different Tx preset conditions. At the same time, you can change Output_DiffSignalP4 with the

corresponding Preset value selected. In this design, Preset_Index is set as 4.
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SS | EveDiff_Probe
EyeDiff_Probe1

—AAN—

R

R4 ﬁ N

R=50 Ohm =
s AAA—

R
R13
R=50 Ohm

After running the simulation, the waveform is saved in the dat a/ wavef or ns directory with the name

PCle_Transmitter_Test_ Preset_DiffSignal_HDF5.h5.

Add-in Card and System-Board Test Examples

Add-in_Card_Tests

This design is used to perform the analysis of add-in card by connecting to the compliance base board.

EyeDiff_Prote
= = = EyeDiff_Probet
BGA Packags_modst c J
26 Transmission_Ling Model =L
e C=120 rF A .
i I : R14 ﬁ -
= R=50 Ohm —
LY ANA =
71 ~
- c2 R13
RE o C=180rF R=50Chm

-
R=50 Ohri®» =
R=50Chm & R=500nm 7T

After running the simulation, the waveform is saved in the dat a/ wavef or s directory with the name PCle_Add-

in_Card_Test AMI_HDF5.h5.

System_Board_AMI_Tests

This design is used to perform the analysis of system board by connecting to the compliance load board. The output of

the design is generated at Output_Data and Output_Clock of the Eye_Probe.

ode|_Separate_Antpsd E:é;:;m;:

=13 1¥]
(=

For System Board test, the Compliance application requires Signal Waveform and Reference Clock ( .

h5) files to perform Offline analysis.

After running the simulation, the waveform is saved in the dat a/ wavef or ns directory with the name

PCle_System_Boards_Test_Clock_AMI|_HDF5.h5.
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PCle Channel Simulation Examples

Channel_Topology_AMI

This design displays a PCle connection from transmitter to receiver. It contains IBIS AMI components and is used to

perform end-to-end channel compliance testing from Tx to Rx.

Re R2
R=50 Ohm@ R=50 Chm

After running the simulation, the waveform is saved in the dat a/ wavef or s directory with the name

PCle_Channel_AMI_HDF5.h5.

Channel_Topology_TX_RX

This design displays a PCle connection from transmitter to receiver. It contains Differential Transmitter and Receiver

components and is used to perform end-to-end channel compliance testing.

REESFalTime=20 psec
Mode=Bit Fils
Excludeload=no. =
EQMeode=Specify FIR aps

After running the simulation, the waveform is saved in the dat a/ wavef or s directory with the name

PCle_Channel_Generic_HDF5.h5.

Channel Compliance S-parameter Examples

Full Link S-Parameter

This design is used to perform the S-parameter analysis of the PCle 3.0 channel topology.

Termt

After running the simulation, the output is plotted for Differential return loss (SDD11) and Common mode return loss
(SDC11) with the specified PCle standard margin.
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Running PCle 3.0 Compliance Tests on
Infiniium Offline

In the PCle 3.0 Compliance Test Bench Simulation Setups section, all the simulation examples generate signal
waveforms in . h5 format. You can run the compliance test on these waveforms using the Keysight Infiniium Offline

software.

Running PCle 3.0 Transmitter Tests

To perform compliance tests, follow these steps:

1. Launch Infiniium Offline.
2. Select Analyze > Automated Test Apps > N5393D/N5393E PCIExpress Test App to open the PCle application.

3. Under the Set Up tab:

a

b

. Select Device as PCle 3.0.

. Select Test Point as Transmitter Tests.

Select Reference Clock as Clean Clock.

. Select Power Level as Half Power Level.

Select Use Saved waveform

A% PCI Express - PCIE Devicel
File View Tools Help

Dw d| "»@ |
SetUp ISelectTests | Configure | Connectl Run Tests I Automation I Results I Html Reportl
i rDevice | r TestPoint———— [ TestInformation— [~ DataLane—
= " PCIE 1.0a [v] Transmitter Tests Reference Clock o
" PCIET1 [~ Eaualization Preset I~ ssc +
 FCIE2D Tests ¥ Clean Clock
: [~ Add-in Card Tests De-emphasis Mode | | ™ Lane 1
Select Tests {* PCIE3.0
€ Ex e [~ System Board Tests INnne vl
Deviee D | |l RefClk Tests I Lane?2
IDe\ﬂ'ce i I Receiver Calibration
Configure Power Level s
—SigTestEmbed— —SaJedwa;aeﬁmn— i Full
: I e @ Half
SigTest 5- Data Rate [ Lane 4
Connect Parameter Setup Saved waveform e
Setup  25GTls
" 50GTis I Lane5
—Receiver Test Setup———— Test Report
beiiiTesE Ext e | ’7UserCommerms:

4. Click Saved waveform Setup.

The Offline Setup dialog box is displayed.
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5. Under the Offline Setup dialog box:
a. Select Signal Type as Single Ended.

b. Click Browse to select the P-channel and N-channel waveforms.

or

g Offline Setup

(=@ =]

Signal Type
’7 {* Single ended " Differential

Load differential signal wawveform (~wim™ h5):
IC ADSK_WoddDSK_ADS_2015_0PDE_DGWPCle\PCle30_DesignG

Load D+ signal waveform [~ wim'™ h5):
IC:\DS K_Word\DSK_ADS_2015_07PDE_DGWPCle'\PCle30_DesignG

Browse

[
N

Load D- signal waveform (*.wim'™ hb):
|C:\DS K_Wor\DSK_ADS_2015_07PDK_DGWPCle'PCle30_DesignG

Browse

Done |

c. Click Done.

6. Click the Select Tests tab.

a. Select all the Signal Quality and Common Mode Voltage tests.
% POl Express -- PCIE Device 1 *
File View Tools Help

D@ d|l "Zar |2 &e
[ Task Flow |

SetUp

SetUp Select Tests |Conﬁgure I Connectl Run Tests | Automation | Results | Html Report
B[] @ AllPCI Express Tests
E|D @ (1/14 Unavailable) PCIE 3.0 Tx Tests (3.0 GT/s)
ED @ (1/14 Unavailable) Transmitter {Tx) Tests
E|El O Signal Quality
) Unit Interval
) Reduced swing Tx voltage with no TREQ
) Min swing during EIEQS for reduced swing
) Uncorrelated total jitter
) Uncorrelated deterministic jitter
) Total uncorrelated PW1
) Determinisic DjDD uncorrelated PW]

Select Tests

) Data dependent jitter
) Pseudo package loss
I':'ID @ (15 Unavailable) Common Mode Voltage

=] @ Tx, DC common mode voltage
@ DC common mode voltage
E| Tx, AC common mode voltage
| [#]® AC-CM valtage (4GHz LPF)
. [#]® AC-CM voltage (30kHz - 500MHzZ)
-] @ (1/2 Unavailable) Tx, Absolute delta of DC common mode voltage
@ Absolute delta of DC common mode voltage between D+ and D-
OO (unavailable) Absolute delta of DC commen meode voltage during LO and Idle
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7. Under the Connect tab:
a. Select | have completed the instructions.

b. Click Run Tests.

3 PCIExpress -- PCIE Device1*
File View Tools Help

D& d| 25T

] "setup | sekctTests | Confre Comect | run Tests | Automation | Reauts | ol Reprt |

R
be run. Comnect to PCI Express Transmitter Package Pins (SMA connection)
sl
oed: Step Notes
colowthese v

=
e =
e
i e L ren” [T
—
L e o
e —
Ensure comect polarity:
+ Comneet D toChamme 1
+ ComneetD-to Chamnet3
s e
[ [T —
Gures S

Once the tests are completed, you can view the test results under the Results tab.

¥ PClExpress - PCIE Device1 *
File View Tools Help
Dl »2ar|[xk

Task Flow _| setUp | Select Tests | Configure | Connect | Run Tests | Automation Results | Himl Report |

TestName [ ActualVal | Margin | Pass Limits I
/ Tx, Unit interval (PCIE 3.0, 8.0 GT/s) 125.0000ps  50.0% 1249600 ps <= VALUE <= 125.0400 ps
/ Tx, Reduced swing Tx voltage with no TxEQ (PCIE 3.0, 8.0 GT/s, Low Power) 0.0000 ¥ 100.0% VALUE <= 1.3000V
/ Tx, Min swing during EIEQS for reduced swing (PCIE 3.0, 8.0 GTfs, Low Power) 546.8 MV 135.7%
/T, Uncorrelated total jitter (PCTE 3.0, 8.0 GT/s) S503ps 69.6%
/ T, Uncorrelated deterministic itter (PCTE 3.0, 3.0 GT/s) S 59.8%
/T, Total uncorrelated PWI (PCIE 2.0, 3.0 GT/S) 12741ps  46.9%  VALUE <= 24.000ps
 Tx, Determinisic DiDD uncarrelated P (PCIE 3.0, 8.0 GT/) e 103.8% VALUE <= 10.000 ps
f Tx, Data dependent jitter (PCIE 2.0, 8.0 GT/s) 3876ps  785%  VALUE <= 18.000ps
/ Tx, Pseudo package loss (PCIE 3.0, 8.0 GT/s) 864mdB  7L2%  VALUE >=-3.000cB
/ Tx, DE common mode voltage (PCIE 2.0, 8.0 GT/s) 000V 0.0%  0.0000V <=VALUE <= 3.5000 V
/ Tx, AC common mode voltage - 4GHz LPF (PCIE 3.0, 8.0 GTfs) 1.5330mV  L0%  0.0000mY <= VALUE <= 150.0000 mV
/T, AC common morde voltage - 30KkHz to S00MHz (PCTE 3.0, 8.0 GT/s) S40.0mmY 19%  0.0000mY <= VALLE <= 50,0000 mV
/ T, Absolute delts of DC common mode voltage between Do+ and D- (PCTE 3.0, 3.0 GT/S) 800 Y 100.0%  VALUE <= 35,000 m¥

You can also view the HTML report under the HTML Report tab.
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! .
:: PCI Express -- PCIE Devicel * -

File View Tools Help
Dedl HwiEr|RsE

Task Flow _| 'set Upl Select Tests | Conﬁgurel Connectl Run Tests | Automation | Results  Himl Report

SetUp

: ;‘ Agilent Technologies j

Select Tests PCIl Express Test Report

Overall Result: 2]

e | TestConfigurationDetails
BeviegiB T pevice 1
[Presetype T None

Test Session Details
linfiniium Siff Version | [05.20.0000
linfiniitm iodei Nismber (23004
{Application SW Version 2.2
DDebug Mode Used Ho
[CastTestDate (20150324 154517 UTC +05:30

Summary of Results

Failed| 0
Passed| 12
Total| 13

| |

‘ 13 Tests |\J’|ew,|’5ave,|'Print detailed HTML results. ‘Connection: PCIE 3.0 Tx Pins v

Running PCle 3.0 Equalization Preset Tests

For Equalization Preset Tests, the Infiniium supports only . bi n format. Convert the HDF5 waveform from ADS to . bi n

format.

m This tests requires Preset _Di f f Si gnal P4. bi n to be available in the folder. If not, generate the
Preset _Di ff Si gnal P4. bi n file.

To perform compliance tests, follow these steps:

1. Launch Infiniium Offline.

2. Select Analyze > Automated Test Apps > N5393D/N5393E PCIExpress Test App to open the PCle application.

m Open the extracted . h5 file and save the waveform (Save > Waveform) with the same file

name in . bi n format. Ensure All Data is selected while saving the file.
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3. Under the Set Up tab:

Select Device as PCle 3.0.

Select Use Saved waveform.

f. Click Saved waveform Setup.

. Select Test Point as Equalization Preset Tests.
Select Reference Clock as Clean Clock.

Select Power Level as Half Power Level.

3% PCI Express -- PCIE Device 1 *
File View Tools Help

e lf@]=]

D@ d| e )@

Device
" PCIE1.0a
' PCIE1.1
" PCIE20
& PCIE3.0

" Express Card 1.0
Device |D:
Device 1

SigTest Embed—

SigTestS-
Parameter Setup

— Receiver Test Setup

SetUp | Select Tests | Configure | Connect | RunTests | Automation | Resuits | Him Report |

~TestPoint " [ TestInformation—| —DataLane
[ Transmitter Tests Reference Clock
o Eaulizsion Preset | | [ SSC e
Tests [V Clean Clock
I~ Add-in Card Tests De-emphasis Mode | | [ Lane 1
[~ System Board Tests None - I
I RefClk Tests I Lane2
™ Receiver Calibration
F'or.n:er Level [ Lane3
—Saved waveform——— | & Full
[ Usesaved & Hal
Saved waveform Data Rate LLEES
Setup  25GTls
€ 50GT/s [™ Lane5
—Test Report
User Comments:

| | 0 Tests Fobwmucmmdescbemustmvimnt

[connection: PCIE 3.0 TxPins |

g. Click Browse to select Preset _Di f f Si gnal P4. bi n in the Offline Setup dialog box.

h. Click Done.

4. Click the Select Tests tab.

a. Select Preset #0.

X POl Epress - PCE Divice 1 *

File Weew Toch Help
Dad| &0

r|s %o

EEE

Setp Sekect Tests | condgure | Connect | Run Tests | Automaton | Resuits | bami Report |

E-[]0 ANRCI Express Tests
5[0 PCIE 30 Tx Tests (8.06Tj)

B[00 Equakoation Presels

B O De-amphusis P2
B O Presetad

F O Deemghass P3
O Breset 35

O Preset #6

(Chck @ Lest’s mamve to see description)

| #Tests  Chack the test(s) you mouddlhe lorun  Connestion: POIE 30 Ts Prs
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5. Under the Connect tab:
a. Select | have completed the instructions.

b. Click Run Tests.

Once the tests are completed, you can view the test results under the Results tab.

r?ﬂﬁmapmsupmwu:- El@‘

File View Tools Help

DEdE| "»2ar | Xk

SetUp | Select Tests | Configure | Connect | Run Tests | Automation Results | Hirl Report |

Test Name [ Actual val Pass Limits |
/ Tx, De-emphasis Preset 20 (PCIE 3.0, 8.0GT/s)  6.0009d8 50.0%  -7.5000 6B <= VALUE <= -4.5000 d8
/Tx, De-emphasis Preset #1 (PCIE 3.0, 8.0GT/s)  -3.5004d8  50.0%  —4.5000d5 <= VALUE <= -2.5000 dB

/ Tx, De-emphasis Preset =2 (PCIE 3.0, 8.0 GT/s)  -4.4006d8 50.0%  -5.9000d8 <= VALUE <= -2.9000 dB
/ Tx, De-emphasis Preset #3 (PCIE 3.0, B.0GT/s)  -2.5003d8  50.0%  -3.5000dB <= VALUE <= -1.5000 dB

Details: Tx, De-emphasis Preset #3 (PCIE 3.0, 8.0 GT/s)

/a1 |
IPm'Inr |\|'.|he | =
Pass | imits [-3.5000 ARt -1. 5000 AR S

W 4Tests |4 results shown. [Himl Report] tab shows detals | Connection: PCIE 3.0 Tx Pins.

You can also view the HTML report under the HTML Report tab.
F?F:EPCIExprﬁsnPCIEDcvkel' el=]=]

File View Tools Help
DEd|l Wrir|lké&

SetUp | Select Tests | Configure | Connect | Run Tests | Automation | Resuits Himl Report |

5:-' Agilent Technologies

PCI Express Test Report
Overall Result: [¥

[Debug Mode Used o
[EastTestbate I (2015-03-24 16:56:05 UTC +05:30

Summary of Results

Test Statistics
Failed| 0
Passed| 4

| Total| 4

Margin Thresholds
Warning =<2%
o

[ aTests  View/Save Print detailed HTML results,  Conmection: PCIE 3.0 Tx Pins
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